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PrintSmith Scheduling Module Overview 
The PrintSmith Scheduling module is a manual scheduling system that allows you to 
electronically organize tasks and device usage within your shop. Access to the Scheduling 
module’s features and setup is controlled through the Schedule Board Manager. 

The Scheduling module is an optional module that is protected by hardware key access. 
User privileges are set using the standard PrintSmith security settings for group access. 

Note: The Scheduling module integrates seamlessly with the Tracker module, though 
you do not have to own the Tracker module to use the Scheduling module. 

 About Scheduling  
PrintSmith Scheduling is “manual” in the sense that the workflow is controlled by the users 
and adjustments are made by hand, not dynamically as with some other scheduling 
software. It basically represents the “whiteboard” approach to scheduling, but in an 
electronic format that allows you and other PrintSmith users to view and make 
adjustments to the schedule from the convenience of your computer workstation. 

Every company has a unique scheduling method. The schedule may be as simple as a 
daily printed spreadsheet, or as complex as an entire wall covered with job tickets 
representing weeks or months of press and bindery runs. A typical print shop scenario for 
scheduling consists of a large corkboard, blackboard, or whiteboard, with time versus the 
print shop resources—presses, binderies, packaging, and other machines and activities. 

Typical Whiteboard Schedule 
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Information about the job is written on the whiteboard in the position of the day or time it is 
scheduled versus the resource that is using. Some type of tag—usually color-coded 
magnetic or paper strips—can be applied to mark progress or expose issues. For 
example, green can indicate stock has been received for a job, and red can mean that the 
job is behind schedule. 

The schedule is reviewed and updated several times a day by several people—from the 
production planner to the scheduler, the shop manager, customer service representatives, 
machine operators, and account managers. 

The PrintSmith Scheduling module is very similar in that it is modeled after a familiar 
concept that works—a manual tool that is extremely flexible, convenient, and easy for 
everybody in the plant to understand at a glance. 

Scheduling Module Users 
PrintSmith Scheduling will be used by almost every member of your organization. 

• Your scheduler and production planners will find the module invaluable for optimizing 
task execution and device usage. 

• Managers will use the Department Schedule to get a big-picture view of the workflow 
throughout the plant for days or weeks ahead of time, and use Scheduler Reports to 
review post-production data. 

• Production staff—including machine operators, prepress, graphic artists, shipping and 
receiving, and so on—can view the scheduling information that is meaningful to them 
in My Work Center and get a heads-up on changes that will affect them throughout 
the day. 

• Customer Service Representatives can also view the Department Schedule to offer 
feedback to customers about the status of their jobs. 

• Users of the PrintSmith Tracker module can access the Tracker Console from the 
Scheduling My Work Center feature and utilize both modules at one time. 
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Key Concepts and Terminology 
Before using the Scheduling module, it is important to understand several key concepts: 

 

Cost Centers Cost Centers are the devices, activities, and charges for which a cost 
(charge) is incurred during the production of a job—for example, a 
press or copy machine, design, typesetting, or cutting. On the 
whiteboard, the Cost Center is the resource whose use must be 
scheduled. 

There are no predefined Cost Centers in PrintSmith Scheduling. You 
must name and configure them. You may want to look at the 
resources you use in your current scheduling process to help you 
decide how to define Cost Centers. Keep in mind that Cost Centers 
will be assigned to the devices and activities in your PrintSmith 
Charge Definitions, Press Definitions, and Copier/Digital Definitions. 
This links the charges and devices used in a job to a Cost Center so 
that they appear in the schedule. 

The Scheduling module also allows you to set up parallel Cost 
Centers to use as alternatives if desired Cost Centers are 
unavailable. 

 

Departments  Departments are groups of related Cost Centers. For example, you 
may have set up Cost Centers called Design, Typesetting, and 
Platemaking. These can be grouped together in a Department called 
Prepress. 

You define the Department names and the groupings they include. 

 

Tag An individual task within the production of a job to which a Cost 
Center can be assigned—for example, typesetting, printing, or 
folding a brochure. A tag has an associated duration and priority that 
it may inherit from the Cost Center.  

Using the white board analogy, the tag is often assigned a color to 
indicate status or draw attention to issues.  

Tags are given a sequence number so that tasks are scheduled and 
produced in a logical order. 
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Using the Schedule Board Manager 

Launching the Schedule Board Manager 
The Schedule Board Manager controls access to the features of the Scheduling module. 
To open the Schedule Board Manager from the Admin menu, click Schedule Board 
Manager. 

Opening the Schedule Board Manager 

 

Select Schedule 
Board Manager 

 

Note: If you do not see the Schedule Board Manager option, there is a problem with 
your hardware key. Contact EFI PrintSmith for assistance. 

 

The following functions can be launched from the Schedule Board Mgr: 

• Job List (New Tags): View a list of all jobs to be scheduled, and open individual jobs 
and create tags to be scheduled. 

• Show Departments: View and schedule jobs by department. 

• Show Cost Center: View and schedule jobs by Cost Center. 

• Late & Complete Tags: View a list of all tags which are late or complete. 

• My Work Center: A view for production personnel of all tags assigned to the selected 
Cost Center on a particular day. My Work Center is integrated with the Tracker 
module, if it is part of your PrintSmith setup. 

• Edit Departments: Set up the Departments, such as Bindery, Press, and Prepress, 
which are utilized within your shop. 
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• Edit Cost Centers: Set up the Cost Centers, such as Design, Typesetting, press, and 

copiers, which are used in your shop, and assign them to Departments. 

• Preferences: Designate production milestones, and set color preferences for 
milestones, tags, and grids. 

• Reports: Run scheduling reports. These are separate from Report Writer reports. 

Schedule Board Mgr 
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Setting up PrintSmith Scheduling 
Before you begin using Scheduling, you must complete some initial setup procedures: 

• Adding Departments 

• Adding Cost Centers and assigning them to Departments 

• Creating custom groups 

• Assigning Cost Centers to Press Definitions, Copier/Digital Definitions, and Charge 
Definitions 

• Designating preferences for Milestones, Tag color options, and grid color options 

• Designating user preferences for Work Center appearance on a per-workstation basis 

Adding Departments 
Departments are organizational groupings of Cost Centers. In your print shop you might 
have the following departments: Prepress, Press, Digital, Large Format, Bindery, and 
Mailing. 

Departments can then be further defined by the assigned Cost Centers. Sample 
Department to Cost Center assignments are shown in the following table. 

Example Department to Cost Center assignments 

Department Cost Centers 
  

Prepress Design, Typesetting, Proofing, Platemaking 

Press Ryobi, Heidelberg, AB Dick 

Digital Canon, Next Press, Xerox 

Large Format Vutek, Epson 

Binding Cutter, Folder, Laminator 

Mailing Tab Insertion, Inkjets 
  

 

Note: Read the section “Adding Cost Centers” on page 12 for a definition of Cost 
Centers. 

To add Departments: 

1. Click Edit Departments in the Schedule Board Mgr. The Departments window 
opens. 

2. Click New. 

3. Enter a Title for the Department, for example, Bindery. 
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4. Designate the Department Capacity. This is the maximum number hours that can be 

assigned to the Department. 

• Select Sum of Cost Centers to use the sum of all Shift Hours for the assigned 
Cost Centers (see “Setting Shift Hours” on page 16), or 

• If one employee works on multiple Cost Centers, clear Sum of Cost Centers to 
enable the Hours text box. Enter the total number of hours that can be 
scheduled based on the employee availability. 

5. Click Save. 

Departments > Departments tab 
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Adding Cost Centers 
Cost Centers are the machines, devices, and activities which generally incur costs during 
the different stages of producing a job. Cost Centers are grouped into Departments and 
the schedule can be viewed from the Cost Center or Department perspective. 

Cost Centers > Setup tab 

 

Selecting a Process 
Stage Type automatically 
sets the Process Stage 
grouping 

Select a Department, or 
add a new Department 
to assign 

Select files of type .gif, 
.jpg, or .png. 

 

Note: The maximum number of Cost Centers that can be created is 32,766. For 
additional limitations, see “Appendix A: Limitations” on page 50. 

To add Cost Centers: 

1. Click Edit Cost Centers in the Schedule Board Mgr. The Cost Centers window 
opens. 

2. Click New. 

3. Enter a Title for the Cost Center, for example, A.B. Dick. 

 Note: The Title is limited to 48 characters. For additional limitations, see “Appendix 
A: Limitations” on page 50. 

4. Enter a Code. The Code is optional and customizable. It allows you to differentiate 
between two Cost Centers that are similar. For example, if you have two machines, 
one that is new and one that is old, you might code them as new and old, or main 
and overflow. 
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5. Enter a Device ID. The Device ID is optional, and is specific to devices supported by 

PrintSmith, such as Fiery. 

6. Enter the Minimum Minutes per Job. This is the minimum unit of time considered for 
costing on this device or Cost Center when creating new tags. 

7. Select a Department from the list to which the Cost Center will be assigned.  

Note: If no Departments appear on the list, click the button to the right of the 
Department field to open the Department window and add a new 
Department. 

8. Select an Image to display with the Cost Center by clicking Browse to the right of the 
Image field.  

Note: Use images supplied by PrintSmith, or create your own. Supported file 
formats are .png, .jpeg, and .gif. For best appearance, images should be 150 
x 150 pixels or smaller. Full size digital images are not recommended. 

  Place all new images on the Master Station in the Shared Images folder. 
From there, you can assign images to or use from any workstation. 

 

Add a shared image for Cost Center display 
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9. Select a Process Stage Type from the list. Your selection determines which option, 

either Generic, Prepress, Production, or Bindery, is selected. The Process Stages 
determine how Cost Center activities are sequenced within the Schedule. For a 
description of how PrintSmith assigns a weighting to each type, determining how they 
will be sequenced, see Appendix B. 

The Process Stage options can be overridden. 

Note: For cutting Cost Center definitions—this can be either PrePress or Bindery—
select PrePress. The PrintSmith Charge Definition you assign to the Cost 
Center will apply the appropriate process stage. For more information, see 
the description of the Cuts are PrePress option in the PrintSmith User 
Reference Guide. 

 

10. In the Delay Time Minutes section, enter a time in minutes Before this Center, 
After this Center, Before sequenced tags, and/or After sequenced tags. This 
allows you to account for time between tasks that is not included in the processing. 

11. Click Save. The attributes of the Cost Center are saved, and the Cost Center appears 
in the listing of the assigned Department. 

Departments, with Cost Centers assigned 

 

Assigned Cost 
Centers are displayed 
in blue text below the 
Department 
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Setting Up Parallel Cost Centers 
While most Cost Centers may not have Parallel Cost Centers, this tab allows you to 
indicate an available, alternative Cost Center device of similar capabilities to be used, if 
the selected Cost Center is at full capacity during a scheduling period. 

For example, if you have two cutters, one of which you use for overflow, it can be set as 
the Parallel Center for your main cutter. 

To designate a parallel Cost Center: 

1. On the Cost Centers window, select the Parallel Centers tab. All Departments and 
Cost Centers are listed. 

2. Click in the column to the left of the Cost Center that should be “parallel” to the Cost 
Center displayed in the Title. A check mark appears next to all selected Parallel 
Centers. 

3. Click Save. 

Cost Centers > Parallel Centers tab 

 

Check the 
Parallel 
Center 

Note: A maximum of 26 Parallel Cost Centers can be associated with each 
Cost Center. For additional limitations, see “Appendix A: Limitations” on 
page 50. 
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Setting Shift Hours 
For each Cost Center, it is possible to set up to three shifts per day. This allows you to 
account for lunch, other breaks, or regularly-scheduled maintenance time in which Cost 
Center machines are not operational. The total hours available per day for using the Cost 
Center are displayed at the bottom of the Shift Hours tab. For days in which your shop is 
not open, such as Saturday and Sunday, do not enter any shift hours. 

Note: In this context, shift hours do not apply to personnel. 
If you try to schedule a task on the device during a non-operational time, such as a 
weekend or lunch break, PrintSmith indicates to you that the Cost Center is not available. 

Note: Although PrintSmith warns you if a Cost Center is scheduled during a non-shift 
time, you can still schedule it during this time. This allows flexibility for scheduling 
of overtime. 

In the following example, the Shift Hours for the Cost Center have been set up for 
continuous operation between 8 a.m. and 5 p.m., Monday through Friday. 

Cost Center Shift Hours available for continuous operation Monday - Friday 

 

Top box is start of Shift 

Bottom box is end of 
Shift

Normal range of 
available Shift 
Hours for each 
day 

  

To set Shift Hours: 

1. On the Cost Centers window, select the Shift Hours tab. 

2. For each day of the week that your shop is open, enter a start time, such as 8:00 
a.m., in Shift 1. 
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3. If the Cost Center runs continuously, without break, enter an end time, such as 5:00 

p.m., below the start time you entered in Shift 1. Then, continue entering start and 
end times for Shift 1 for each day of the week. The total operational time each day for 
the Cost Center is 9 hours. 

Note: Shift 1 must start at 12 AM or later. The start time must always be less than 
the end time. Each shift must start later than the previous shift—shifts 
cannot overlap. 

4. If you want to allow for additional shifts, or breaks, enter an end time of 12:00 p.m. in 
Shift 1. Then, enter a start time of 1:00 p.m., and an end time of 5:00 p.m. for Shift 2. 
Continue entering start and end times for Shift 1 and Shift 2 for each day of the week. 
In this instance, the total operational time each day for the Cost Center is 8 hours. 

5. Click Save. Available Shift Hours for the Cost Center are saved and are applied in the 
Scheduling module. 

Note: The same instructions apply to entering Shift Hours for Shift 3. 
 

In the example below, the Shift Hours for the Cost Center have been setup with Shift 1 
from 8 a.m. to 12 p.m. and Shift 2 from 1 p.m. to 5 p.m., allowing for a lunch break, 
Monday through Saturday.  

Cost Centers > Shift Hours, 2 Shifts with lunch break Monday - Saturday 

 

1 hour break 
between Shift 
1 and Shift 2 
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Setting Tracker Options 
Use the options on the Tracker tab to customize the Cost Center for production data 
tracking if using the Tracker module. These options relate to job routing. 

 
To set Tracker options: 

1. Select a Location X-ref. This list is populated from the Production Locations table, 
and ties the Scheduling module with the Tracker module. The Location cross 
reference (X-ref) is the activity related to the Cost Center. 

2. Select Mark INV ready for Pickup if this Cost Center is the last step in the routing of 
the job and the invoice will be marked ready for pickup. 

3. Select Treat as Non-Production step, no cost if there should be no charge for this 
Cost Center, for example, Proofing. 

4. The Completion Category is linked to production and can be used to 
automatically date stamp the completion of a step in the Tracker. Not all Cost Centers 
will have a Completion Category. 

5. Click Save. 
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Creating Custom Groups 
The Custom Groups feature of Departments allows you to create a customized super view 
of any Cost Center devices, regardless of the designated Department. Up to thirty (30) 
Cost Centers can be added to each Custom Group created. 

To create a Custom Group: 

1. On the Schedule Board Mgr, select Edit Departments > Custom Groups. 

2. Click New. 

3. Enter a Title for the Custom Group, such as Copy Services. 

4. Click Add Cost Center. A window opens with all Cost Centers listed. 

Cost Center selection window 

 
 

5. Select a Cost Center from the list and click Select. The Cost Center is listed in blue 
below the Custom Group name. Continue this process until all Cost Centers have 
been added to the Custom Group. 

6. Click Save. 
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Assigning Cost Centers to Press, Copier/Digital, and 
Charge Definitions 
Once you have created your Cost Centers and assigned them to Departments, you need 
to assign the Cost Centers to the devices and activities in Charge Definitions, Press 
Definitions, and Copier/Digital Definitions, so that the charges and devices used in a job 
are linked to a Cost Center and appear in the schedule. 

Press Definitions 
Open Pricing > Press Definitions, and for each press, select a Cost Center from the list. 
All Cost Centers created with a Process Stage Type of Printing are available for selection. 

In the following example, the A.B. Dick Cost Center is assigned to the A.B. Dick 9870 (T 
Head) press. 

Press Definitions 

 

Select Cost 
Center 
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Copier/Digital Definitions 
Open Pricing > Copier/Digital Definitions, and for each copier, select a Cost Center 
from the list. All Cost Centers created with a Process Stage Type of Copying are available 
for selection. 

In the following example, the Canon Cost Center is assigned to the 8.5 x 11 B&W Copy 
definition. 

 

Copier/Digital Definitions 

 
 Select Cost Center 
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Charge Definitions 
Open Pricing > Charge Definitions, and for each charge, select a Cost Center from the 
list. All Cost Centers created are available for selection, except those with a Process 
Stage Type of Printing or Copying. 

In the following example, the Platemaking Cost Center was assigned to the Computer 
Time charge. 

Charge Definitions 

 
 

 Select Cost Center 

 

Note:  For Charges, the Cost Center assignment must occur at the Master Station. 
Then, a pricing update must be applied to all workstations. Invoices created prior 
to the Cost Center assignment should be recalculated (using Invoice > 
Document Totals) to display the latest Charge Definition Cost Center in the job.  

 

 
Page 22 



PrintSmith Scheduling Module 

 

Setting Preferences 
In the Scheduling module Preferences, you can designate preferences for the Scheduler 
and User. Scheduler preferences include milestone settings and color options for tags and 
the schedule grids. 

Setting Milestone Preferences 
Milestones indicate the completion of an important event within the production process. 
The milestone color blocks are displayed throughout the Scheduling module as a quick 
visual indicator for everyone involved in the job’s production of when these tasks have 
been completed.  

There are two types of milestones: 

• Stock: Links to the PrintSmith Stock Order. When the stock is received, this 
Milestone is automatically checked. 

• Custom: Can be linked to Cost Centers. Depending on the job’s setup, when the tag 
associated with the Cost Center is completed, the Milestone is automatically checked.  

Preferences > Scheduler tab 

 

Select Cost 
Center for 
Custom 
Milestones 

Click to open 
Color Picker 
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Setting Tag Color Options 
Tags that are scheduled correctly without any issues are displayed in black. To draw 
attention to any issues with a tag’s scheduling, set the following Tag color options. 

• Out of run sequence (default color = red): Appears when the tag is scheduled out of 
sequence. For information on how to sequence tags, read about the Tag Editor in 
“Creating Individual Tags for the Job” on page 30. 

• Non-Production Time (default color = pink): Appears when a tag enters non-
production time, as determined in Cost Center > Shift Hours. 

• Past Wanted By date (default color = orange): Appears when a tag is scheduled in a 
slot that comes after the customer Wanted by date. 

• Completed Tags (default color = green): Appears when the tag has been marked as 
complete in the Tag Editor. 

Example of tag color options in the Chart Job window 

 

Completed tag 

Scheduled in 
non-production 
time 

Out of run 
sequence 

Setting Grid Color Options 
The Department Schedule, Cost Center View, and My Work Center windows provide 
different calendar views of the schedule. Color options can be set for the calendar grid to 
allow easier viewing. 

Grid color options can be set for the following: 

• Today’s grid background (default color = pale green): Today’s date is displayed in 
this color within the calendar grid. 

• Center shut time (default color = pale gray): Non-production time, as set in Cost 
Center > Shift Hours, is displayed in this color within the calendar grid. 

• Out of current month (default color = pale yellow): In the Cost Center View > Month 
tab, those days which are not in the current month are displayed in this color within 
the calendar grid. 
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Setting User Preferences 
The user preferences affect the Department Schedule (Show Departments). 

Preferences > User tab 

 

Height is 
measured in 
pixels 

Calendar Cells 
The Calendar Cells preference increases the height of the viewable area on the 
Department Schedule. For example, you can change the cell size to fill the entire window 
if you would like to view the schedule information for a single Cost Center at a time.  

Use the scroll bar to change the height, which is measured in pixels. You may need to 
experiment with this preference to adjust the height to your liking. 

Sort Department Cost Centers  
By default, all Cost Centers are sorted alphabetically by title on the Department Schedule 
when Show all Departments is selected. By process Stage will sort the Cost Centers by 
the Process Stage selected when you set up the Cost Center—Generic, PrePress, 
Production, or Bindery. You can further elect to Sub sort by process Type, which 
determines further how Cost Center activities are sequenced within the schedule. Both 
options can be selected at the same time. 

Auto show scheduler department view at sign on  
Select to open the Department Schedule window automatically when a user logs on to 
PrintSmith on this workstation.  The last Department selected is always displayed. 
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Automatically Show My Work Center 
If you have the Tracker module installed, you can automatically open My Work Center 
when an employee logs in. 

1. From the PrintSmith menu bar, click Admin > Employee Manager to open the 
Employee Manager. 

2. Click Employees, highlight an Employee on the list and click Select. 

3. Click the Personal tab and select Auto show My Work Center at clock in. 

Tracker Employee Personal tab 

 

Auto show 
My Work 
Center option 

When that employee clocks in, the My Work Center window opens to the last selected 
Cost Center. 

For more information on using My Work Center, see “Using My Work Center” on page 47. 

 
Page 26 



PrintSmith Scheduling Module 

 

Using PrintSmith Scheduling 
Once you have completed the initial setup procedures, begin using the Scheduling 
module, tailoring it to meet your shop needs and best enhance your workflow. 

As with other PrintSmith modules, there are multiple ways to accomplish the same 
function. It is simply a matter of finding what is most comfortable for you, and what works 
best in a given situation or for the particular PrintSmith user. 

In the section that follows, you will see how a job moves from invoice creation to the 
schedule, how tasks within a job are sequenced to enhance production workflow, and how 
you can use the Cost Center and Department schedules to maximize efficiency and fully 
utilize your shop’s capacity. 

Scheduling a Job 
Creating an invoice for a job that is to be scheduled is exactly the same. The only 
difference is that when you assign a press or copier/digital device and charges to the job, 
the Cost Centers that you assigned to the devices and charges are associated with the 
job, and its tasks can be scheduled using these Cost Centers. 

Creating the Invoice for a Job 
If you create a press job, the Costing Press (which is normally the same as the Pricing 
Press) selected for the job is associated with a Cost Center, as set up through the 
Schedule Board Manager. 
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Printing Job 

 

The selected 
Press has a 
Cost Center 
assigned and 
is part of the 
Press 
Department. 

If you assign charges to the job, such as Platemaking and Typesetting, these charges are 
also associated with Cost Centers, which could be part of a Prepress Department.  

Pre Press Charges 

 

Paper plates is 
assigned to the 
Platemaking Cost 
Center and is part 
of the Prepress 
Department. 

Typesetting is 
assigned to the 
Typesetting Cost 
Center and is part 
of the Prepress 
Department. 

Create a tag for each task of a job, and schedule each tag using the Scheduling module. 
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Selecting a Job from within the Job List View 
Once you create an invoice, access it through the Job List View for scheduling. To open 
the Job List View, click Job List (New Tags) in the Schedule Board Mgr. All jobs to be 
scheduled are listed. 

Job List View 

 

Select 
opens the 

Tags for Job 
window 

Get opens the 
Invoice for the 
selected item 

Sort the Job List 
by the column 
headers 

Checked 
items have 

been 
scheduled 

 

Note: Invoices that have been marked as on hold are crossed out in the Job List View 
until the hold status is removed through the Pending Document > Location 
window. 

Viewing Tags for a Job 
To view the Job Tags for an individual job, highlight the job in the Job List View and either 
double-click it, or click Select. The Tags for Job window opens. The Job Details and 
charges which are not marked as Excluded from Production are displayed in the upper 
portion of the window. Any existing Tags are displayed in the lower portion of the window. 
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Tags for Job window 

 

Job Details 

Job items 
and charges 
with 
associated 
Cost Centers 

Functionality 
buttons for 
existing tags 

Existing tags 
(once 
generated) 

 

Creating Individual Tags for the Job 
For each job item and charge with an associated Cost Center, a job tag can be created. 
All tags for a job can be generated simultaneously, or each tag can be created 
individually. Tags can be reviewed and modified through the Tag Editor. 

Note: The Tag Editor is accessible throughout the Scheduling module by double-
clicking a tag. 

To create individual job tags: 

Select a job item in the upper portion of the Tags for Job window. Click Add Selection. 
The Tag Editor window opens displaying the lowest level information about the tag, 
including: 

• Job Details. General information needed to make judgment calls about scheduling. 
• Tag Details. Cost Center, Run Date, Start Time, Duration, Priority, Link Sequence, 

Stage, and Delay Minutes for the tag come from information in the job and the Cost 
Center settings, but can be overridden, except for the Stage. This determines where 
and when the tag is scheduled. 
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Note: The Duration for a tag cannot exceed the total shift hours for a day. If this 

occurs, the task should be split and scheduled over multiple days. For 
additional limitations, see “Appendix A: Limitations” on page 50. 

• Milestones. Important events in the overall processing of the job. 
• Status. Unless the tag is Complete or on Hold, nothing is selected. If the tag is placed 

on Hold, the Partially Complete field allows you to enter how much time on the tag 
was completed prior to being placed on hold. 

• Comments. Any information to be included with the tag for the scheduler, production 
personnel, management, etc. 

Tag Editor 

 

Job Details 

Checked 
milestones are 
displayed with the 
tag throughout the 
schedule 

Tag 
Details 

Status of tag Delay 
Minutes 

allow 
buffer 

time 
between 

tags 
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Once you have reviewed the tag information and made any necessary adjustments, click 
File to add the tag to the existing tags list at the bottom of the Tags for Job window. 

Tags for Job window, Add Selection creates a job tag for selected item 

 

Add 
Selection 
creates a 
tag for the 
selected 
item 

Click to open 
schedule

 

Once a tag has been created for an item, the item is displayed in black in the upper 
portion of the window. You can continue creating tags for each of the items using Add 
Selection and making adjustments in the Tag Editor window. 
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As you add tags, the Sequence is automatically updated based on system information. 
For example, if Printing is the first tag added, it initially has a Sequence of 1. If a Plates 
tag is added next, the Plates tag will have a Sequence of 1 and the Printing tag will have a 
Sequence of 2. 

Tags for Job window, Existing Board Tag functions 

 

<Need Cost 
Center> displays 
for job items that 
do not have a Cost 
Center assigned 

Functions 
available for 
selected tag 

As tags are 
added, the 
sequence is 
updated 

Note: Tags can be given the same sequence number. For example, if a Typesetting tag 
(Sequence of 2) of 10 hours is split into 2 tags of 5 hours each so that two people 
can typeset simultaneously, both tags can have a Sequence of 2. 

Creating a Tag to Block Time 
You can create a tag to block open time for the Cost Center for routine daily or weekly 
maintenance, holiday closing, and so on. This  

1. On the Schedule Manager, click Show Cost Center. 

2. In the Cost Center View, select the Cost Center from the list at the top of the window.  

3. From the PrintSmith menu bar, click File > New. The Tag Editor opens. The Job 
Details fields are blank and unavailable except for Description and Notes. Enter a 
description of the reason you are blocking this time, for example, “Weekly stock 
inventory.”  

4. Enter the Start Time and Duration for the tag. 

5. Click File. 
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Generating All Tags for the Job 
When you select the Generate All option in the Tags for Job window, a tag is created for 
each of the line items in the top portion of the window. Items are sequenced based on the 
Process Stage setup for the associated Cost Center, and are scheduled in the next 
available time slot. All items are placed in Hold status, which requires the scheduler to 
verify that the time and placement is accurate before removing the hold status and placing 
the tag on the schedule. 

Note: Items that do not have associated Cost Centers are sequenced first. When this 
occurs, you may wish to delete the tags without Cost Centers, or assign a Cost 
Center to the device or charge before continuing with scheduling. 

Generate All tags, tags on Hold 

 

Tag 
without 
Cost 
Center is 
sequenced 
first 

All 
tags 

on 
hold 

Assigning Cost Centers after Invoice Creation 
Job items for which a Cost Center has not been assigned display <Need Cost Center> in 
the Cost Center column of the Tags for Job window. For Presses and Copiers, a Cost 
Center can be added and then assigned through the Pricing > Press Definitions and 
Pricing > Copier/Digital Definitions. The Cost Center appears in the Tags for Job window. 

For Charges, the Cost Center assignment must occur at the Master Station. Then, a 
pricing update must be applied to all workstations. After these steps are complete, the 
invoice must be recalculated (via Invoice > Document Totals) to display the latest 
Charge Definition Cost Center with the job.  
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Modify Existing Board Tags and Scheduling 
While PrintSmith can automatically update the Sequence of the job tags, it is a manual 
scheduling system, so it does not automatically place the tags in the appropriate place 
within the schedule. Tags in black type are considered scheduled without issue. Tags that 
appear in any other color type, as you have set in Preferences, can indicate that the tag is 
out run sequence, scheduled during a non-production time, or scheduled past the wanted 
by date. 

Manual adjustments to tag scheduling can be made using the Existing Board Tag 
functionality buttons, through the Tag Editor, using the Chart, or through the Cost Center 
or Department views. 

Within the Tags for Job window, with a tag selected in the bottom pane, you can use the 
Existing Board Tag functionality buttons to: 

• Change the Time and Date of a Tag. Use the – Hour and + Hour buttons to change 
to scheduled time for the tag and use the – Day and + Day buttons to change the 
scheduled day for the tag. 

• Change the Slot of a Tag. Tags can also be moved within the schedule using the –
Slot and + Slot buttons. Slots are open spaces of time within the Cost Center’s 
schedule that fit the duration of the selected tag. The – Slot button moves the 
selected tag to the previous time slot that fits the tag. The + Slot button moves the 
selected tag to the next time slot that the tag fits into. 

• Delete a Tag. Tags can be deleted by selecting the tag in the lower portion of the 
Tags for Job window and clicking Delete. This does not delete the item from the job, 
just removes the tag for the item from the schedule. Use Shift + click to select a 
contiguous range, and Ctrl + click to select a non-contiguous range for deletion. 

• Split a Tag. Use the Split button to divide a Tag into two tags, each with half of the 
time. Run time for the tags is back-to-back. 

Note: Special rules apply to splits. Only run times are split, not setup times. If a tag 
is split, the setup time is applied to each split. For additional limitations, see 
“Appendix A: Limitations” on page 50. 

• Hold All Tags. The Hold All tags option allows you to pull all tags for the selected job 
from the active Schedule board and place them in a HOLD state. This can be used 
when the customer calls requesting that production of the job be stopped for some 
reason. 

Note: Holding down the <Option> or <Alt> key while clicking Hold All Tags 
releases all tags from the hold status. 

• Change the Tag. Click Change to open the Tag Editor, where you can modify the 
Run Date and Start Time of the job with respect to scheduling, or modify other 
attributes as necessary. 

Note: For more information on the Tag Editor, see page 30. 
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Showing the Job Schedule 
The Show JOB Schedule button, located at the bottom of the Tags for Job window, 
opens the Department Schedule window with a temporary department of the Cost Centers 
for the tags in the current job. This overview mode provides a “What-If” scenario that lets 
you see how the tags for this job interact with tags already on the schedule, before 
releasing the tags from Hold. 

The tags for the selected job are highlighted in blue within the schedule. 

Temporary JOB Schedule 

 

Temporary Job 
Schedule view 

Tags of 
selected job 
are highlighted 
in blue. 
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Modifying Tags and their Scheduling Using the Chart 
The Chart Job window, which is accessed by clicking Chart in the Tags for Job window, 
provides a graphical charting of the whole job with color indicators that let you know which 
tags are out of sequence or if the tag is scheduled during non-production time. 

Job tags that are sequenced correctly form a stair-step pattern. You can use the +/- Hour 
and +/- Slot buttons to fix the scheduled time of the selected tag. 

Tags for the current job are represented in the Chart job window as an “H” pattern. In the 
bottom of the window, the Cost Center for the selected tag is displayed, and other jobs 
running on the same Cost Center are represented with a bar pattern. 

Chart Job window, tags out of sequence 

 

Graphical view 
of highlighted 
Cost Center 

Today’s time 
marker 

Wanted by 
date marker 

 

 

Chart Job window, tags sequenced correctly 

 

Use +/- 
buttons to fix 
scheduled 
times 

Another tag 
scheduled on the 
same Cost Center 

Selected tag 

 
Page 37 



EFI PrintSmith 8.0 │ Scheduling 

 

Using the Cost Center View 
The Cost Center view provides daily, weekly, and monthly views of the selected Cost 
Center. Access the view by clicking Show Cost Centers in the Schedule Board Mgr. 
When you select the Cost Center from the list, all tags scheduled for that Cost Center on 
the selected Day, Week, or Month are displayed. 

While there are some unique features depending on whether or not you are viewing a 
Day, Week, or Month, some common features throughout the Cost Center View are: 

• Arrow buttons allow you to scroll to next and previous day, week, and month. 

• Details of the highlighted tag are displayed above the calendar grid. 

• Double-clicking a tag opens the Tag Editor. 

• Double-clicking a tag while holding down the Option or Ctrl key opens the Chart Job 
window. 

• There is a progressive drilldown from the month to week to day to Tag Editor views. 

• Tags can be scheduled using drag and drop. 

• Milestones, the three color boxes indicating important events, are displayed with the 
tags. 
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Viewing the Daily Cost Center Schedule 
Cost Center View, Day tab 

 

Select a Cost 
Center from 
the list 

Graphical view of 
the selected Cost 
Center and day 

Turn on/off 
Milestones 

Mini-tags 

Details of the 
highlighted tag 

Navigate to 
the next day 

Open Chart 
Job window 

Double-click tag to 
open the Tag 
Editor 

Note: The selected tag displays as an “H” pattern in the Cost Center graphical display. 
 

Additional features within the Day view: 

• Graphical view of the Cost Center for the selected day. 

• -/+ Hour and -/+ Slot position adjustment options. 

• Duration and Start/End Time details for the selected tag. 

• Ability to turn Milestones off and on. 

• Mini-tags provide quick view of current tag and tag status 

• Chart Job button provides shortcut to open Chart Job window, as an alternative to 
double-clicking a tag while holding down the Option or Ctrl key 
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Viewing the Weekly Cost Center Schedule 
Cost Center View, Week tab 

 

Navigate to 
the next week 

Double-click day 
to drilldown to 
Day tab 

Double-click tag 
to open the Tag 
Editor 

Today displayed 
in green based 
on Preferences 

 

Additional features within the Week view: 

• -/+ Hour, -/+ Day, and -/+ Slot position adjustment options. 

• Duration and Start/End time details for the selected tag. 

• Ability to drilldown to the Day view by double-clicking on a day. 
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Viewing the Monthly Cost Center Schedule 
Cost Center View, Month tab 

 

Navigate to 
the next month 

Double-click day 
to drilldown to 
Week tab 

Out of month day 
set to yellow based 
on Preferences 

 

Additional features within the Week view: 

• + Slot position adjustment option. 

• Ability to drill down to the Week view by double-clicking on a day. 

 

Using the Department Schedule 
The Department Schedule gives you board, usage, and hold views for the selected 
Department or all Departments. Click Show Departments in the Schedule Board Mgr, 
then select a Department or Custom Group from the list to view information about the 
Cost Centers within that Department or Custom Group. You can also select Show all 
Departments to see information for all Cost Centers that have been assigned to a 
Department or Custom Group. 
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Viewing the Department Board Schedule (Board View) 
The Board View of the Department Schedule is a six-day view of the selected 
department’s Cost Centers, which provides the following features and functions: 

• Displays tags, sequenced by scheduled time, on a particular day for a given Cost 
Center. 

• Displays job detail information with milestones above the grid for the selected tag. 

• Displays a bar graph indicating the usage of the Cost Center each day. 

• Highlights Parallel Cost Centers when you drag an existing tag. 

• Drag and drop the selected tag onto a new day or Cost Center. 

• Place the selected tag on hold. 

• Double-click a tag to open the Tag Editor. 

• Double-click a tag while holding down the Option or Ctrl key to open the Chart Job 
window. 

• Navigate through days using the arrow buttons above the grid. 

Department Schedule, Board View 

 

Select 
Department 

Milestones and 
details of 

selected tag 

Cost Centers 
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Today 
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Viewing Cost Center Usage (Usage View) 
The Usage View of the Department Schedule is a six-day view of the selected 
department’s Cost Centers, which provides the following features and functions: 

• Displays Parallel Cost Centers (if any) of the selected Cost Center above the grid. 
This allows you to see optional Cost Centers for scheduling a tag, if the Cost Center 
is utilized at capacity on a given day. 

• Displays a bar graph indicating the time usage of the Cost Center each day. 

• Displays the amount of time out of the available time that is available to be scheduled 
for a Cost Center. For example, if (1:00) of (9:00) is displayed, this means that 1 out 
of an available 9 hours have been scheduled for the Cost Center that day. Or, that the 
Cost Center has 8 open hours that can be scheduled. 

• Navigate through days using the arrow buttons above the grid. 

Department Schedule, Usage View 

 

Scroll 
through days 

Parallel Cost 
Centers  

Visual and 
numerical 
display of Cost 
Center usage 
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Using the Hold View 
The Hold View of the Department Schedule allows you to see all tags on hold for the 
selected department. Within the Hold View you can: 

• See job details for the selected tag. 

• Remove hold status from the selected tag. 

• Open the Tag Editor by double-clicking on a tag. 

 

Department Schedule, Hold View 

 

Show all 
Departments 

Remove 
Hold 

Double-click 
item to open 
Tag Editor 

Note: If the Show all Departments option is unselected, the view returns to the 
Department that was previously selected, as displayed in the grayed-out 
Departments field. 
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Viewing Late and Complete Tags 
Select Late & Complete Tags on the Schedule Board Mgr to view Late and Complete 
tags for all departments or by individual department. 

Late Tags 
Late tags are those with a customer Wanted by date that is past. A tag is also considered 
late if the Start date plus the total run length has lapsed, and the tag is not marked 
Complete. The Late list can be an indicator of customers you need to contact, and allows 
you to place late tags on hold.  You can open the Tag Editor by double-clicking on an 
item. 

Late and Complete window – Late tags 

 

Place late 
tags on hold 

Note: The Tag color for late tags is set in Preferences. 
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Complete Tags 
The Complete tab gives you a quick overview of all tags that have the Complete status 
checked in the Tag Editor. Complete tags must be deleted manually, using the Delete 
Selection button. This feature allows you to turn off the Complete status and reschedule a 
tag if its status was accidentally marked as Complete.  

Use Shift + click to select a contiguous range and Ctrl + click to select a non-contiguous 
range for deletion. You can open the Tag Editor by double-clicking on an item. 

Note: The Tag color for complete tags is set in Preferences. 
Late and Complete window – Complete tags 

 

Delete complete 
tags 

It a tag isn’t 
complete, open 
the Tag Editor 
and change the 
status 

Note: When completed tags are deleted from the Complete list, the job still displays in 
the Job List View as unscheduled. After the produced job is Picked Up, it is 
removed from the schedule (Job List View) and into Account History. 
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Using My Work Center 
My Work Center provides a daily view of the schedule for production personnel to use as 
they perform work at their Cost Centers. The Tracker module is integrated with the 
Scheduling module in My Work Center, if the Tracker module is installed. 

Personnel can select a Cost Center and see what tags are on the schedule board for the 
day. With Tracker integration, they can select the tag they are working in the board view, 
and track their time using the Tracker functions at the bottom of the window. Recorded 
times are automatically updated to the Tracker module. 

Double-click a tag in the Board View to open the Tag Editor, if PrintSmith security (Admin 
> Security Setup) is enabled for access to the Scheduler Job List command. Double-click 
a tag while holding down the Cmd or Ctrl key to open the Chart Job window.  

When an active Tracker record is found, double-click to open it by default. 

My Work Center – Board View 

 

Scroll through 
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Note: Currently, Preferences only pertain to Tracker integration.  
Through Tracker, you can set the option to have My Work Center open automatically 
when an employee clocks in. For instructions, see” Automatically Show My Work Center” 
on page 26. 

Understanding the Mini-tags 
Mini-tags appear on the daily schedule in the Cost Center View window, and on the Board 
View tab of My Work Center. They provide you with at-a-glance information on the status 
of tags within each job. 

There is a mini-tag for each tag within a job. The tag with the “tail” at the bottom indicates 
for which tag you are viewing the information. For example, in the illustration below you 
are looking at the schedule information for the third tag. 

 

Third mini- tag 
has a “tail” 

 

The color of the mini-tag is also meaningful: 

• Green indicates that the tag is complete 

• Gold indicates that the tag is on hold 

• Black indicates everything is proceeding normally 

 

Two tags 
are 
complete 
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Using Reports 
Several reports are included with the Scheduling module. Access them from the Reports 
button on the Schedule Board Mgr instead of the PrintSmith Report Writer. 

 

Clear this window

Select a 
report from 
the list 

Enter date 
range for 
report 

Open new 
window for 
report display 

When you select and configure a report from the Report Type list, the result appears in the 
same window. Click New Report to clear the window, or click New View of Report to 
open a new window to display the report. Use the new view to compare more than one 
report on screen. Use the PrintSmith File > Print command to print the report to a printer 
or file. The following reports are available: 

• Cost Center by Run Date.  Enter a date range, or use the current week and select 
from the list of Cost Centers to produce a list of the jobs run and time used for that 
Cost Center. 

• Cost Center Week View. Select a Cost Center to view the hours used each day of 
the week. 

• Cost Center by Time. View job information, including start and end time, for a Cost 
Center for a specified date range. 

• Department Week View. Select a Department to view the total hours of use of all 
Cost Centers in the Department for each day of the week. 

• Department By Time. View job information, including start and end time, for all Cost 
Centers in the Department for a specified date range. 
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Appendices 

Appendix A: Limitations 
The following limitations apply to PrintSmith Scheduling: 

• The Cost Center Title is limited to 48 characters. 

• The maximum number of Cost Centers that can be created is 32,767. 

• Custom Groups can have a maximum of 30 Cost Centers assigned. 

• A maximum of 26 Parallel Cost Centers can be associated with each Cost Center. 

• The maximum time for a tag cannot be greater than the Cost Center’s total Shift 
Hours for a day. If this occurs, the task must be split and scheduled over multiple 
days. 

• Special rules apply to splits. Only run times are split, not setup times. If a tag is split, 
the setup time is applied to each split. 

Appendix B: Process Type Weighting 
When setting up Cost Centers for your organization, you select a Process Type which 
determines the Process Stage for the Cost Center. PrintSmith Scheduling uses the stage 
to assign a weight to each type. 

The weightings are used as a starting point for determining what order the process stage 
falls in the production process. PrePress comes before Production, Production comes 
before Bindery, and Bindery is the last step in these processes. Within these stages, the 
weightings determine the order the production steps should be completed in. The order 
can be manually changed at the time of scheduling in the cases where you might need to, 
for example, cut something before you pad it or number it. 

 

 

The Process Stage Type 
sets the Process Stage 
grouping, and helps 
detremine the order of 
the production steps 
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The table below shows the four stages, and the weight of the type within each stage (in 
parentheses) where (1) has the highest priority. Process types of equal weighting are 
scheduled based on drag order in the JOB schedule. 

 

Generic Generic (1) 
 Brokering (1) 
PrePress Design (1) 
 Scanning (1) 
 Proofing (2) 
 Cutting (3) 
 Ink Mixing (3) 
 Plate Making (3) 
Production Printing (1) 
 Copying (1) 
Bindery Padding (1) 
 Numbering (1) 
 Cutting (3) 
 Laminating (7) 
 Scoring (8) 
 Inserting (9) 
 Collating (9) 
 Folding (9) 
 Drilling (9) 
 Sealing (10) 
 Tapping (10) 
 Binding (10) 
 Addressing (11) 
 Metering (11) 
 Die Cutting (12) 
 Packaging (13) 
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